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Why we wrote this book

The inspiration for this book came when Felix saw what the car payment would be
on a new Porsche Boxster. He came to me and said, “Dude, I gotta write a book.” Okay, 
you know we’re kidding, but admit it—don’t you secretly wish that for once, when 

someone was doing something strictly for the money, they’d just come out and say so. Just 
once, wouldn’t you like to hear someone admit it? Well, I hate to disappoint you, but I can tell 
you unequivocally that Felix and I absolutely did not write this book for the money. We wrote  
it to get free drugs. All authors get free drugs—it’s in every book contract. Always has been. 

Actually, the reason we wanted to write this book is because of something that is already  
in almost every Photoshop book ever written: the tips. You know—those cool little tips littered 
throughout the sidebars of all great Photoshop books. We found that those little tips were  
often our favorite parts of the book. In fact, Felix and I agreed that frequently we’d read all 
those little sidebar tips first—before we’d ever sit down to actually read a chapter. It’s those 
neat little tips that the great authors include that make using Photoshop so much fun (and 
make their books so great). The only problem is, there’s just not enough of ’em. 

So we thought, “Wouldn’t it be cool if there was a Photoshop book where the whole book, 
cover-to-cover, was nothing but those little tips on the side!” Then Felix jumped up and yelled, 
“Let’s write that book!” I jumped up and yelled, “Yes, yes! We have to write that book. It’s our 
destiny!” Then Felix yelled, “Then I can get my Porsche!” I mean, he yelled, “This book will help 
humanity and be written for the common good” (or something like that. I can’t remember. 
Probably because of all the drugs). 

Is this book for you?
Is this book for you? Are you kidding? This book is so for you that it secretly freaks you out.  
Look, we don’t know you personally, but we know Photoshop people. You’re just like us—you  
love those little sidebar tips just as much as we do. If you didn’t, authors would’ve stopped 
adding them to their books years ago, because, frankly, they’re a pain in the butt to compile. 
But we know what you’re thinking. Sure, you love those little tips—those inside secrets that 
make you look smart at parties and gain respect from your peers, homies, peeps, and other 
esteemed colleagues, but you want something more. You want the one thing that those cool 
little sidebar tips never seem to have. That’s right, graphics. As cool as those sidebar tips are, 
they’re always just a tiny little box with a couple of lines of text (like the sidebar we added 
above left). So we thought we’d expand the explanations just enough to make them more  
accessible, and add an accompanying graphic to enhance each tip’s innate juiciness. They 
must remain “juicy.” They must be “juicy tips.” 

Now you’re probably wondering, “Guys, Photoshop is one amazing program with an unri-
valed power and incredible depth. Couldn’t you have come up with at least 1,000 Photoshop 
tips?” Absolutely. We could have included loads of tips, such as “F7 brings up the Layers pal-
ette,” and “Press G-Shift-G to get the Paint Bucket tool,” but the problem is, those aren’t “Killer 
Tips.” Every Photoshop book has those tips. Heck, books about gardening probably even have 
those Photoshop tips. For a tip to get in this book, it had to be a “Killer Tip.” Each tip had  
to be one that would make the reader smile, nod, and then pick up the phone to call another 
Photoshop user just to “tune them up” with their newfound power. Remember, these are killer 
tips, so be careful. Someone could get hurt.

I N T R O D U C T I O N

TIP

This is a sidebar 

tip. Every great 

Photoshop book 

has a few of them. 

But this book is 

nothing but them. 

A whole book 

of cool sidebar 

tips, without the 

sidebars. 
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Okay, how do I get started?
In my previous Photoshop books Photoshop CS Down & Dirty Tricks and The Photoshop CS Book 
for Digital Photographers, I used a technique that really worked well. I gratuitously mentioned my 
other books in the introduction, just in case I didn’t get to plug them later. No, wait… that’s not 
it. What I did tell the reader was that my books aren’t set up like a novel. They’re purposely not 
designed to make you start at Chapter One and read your way through to the back (where hope-
fully, I’ll again have an opportunity to plug, I mean casually mention, my other books). Instead, this 
book is designed so you can jump in anywhere, in any chapter, and immediately try the tips that 
interest you the most, regardless of your level of experience in Photoshop. You don’t need to load 
any special images from a CD-ROM or go to a Web site to download special photos—these are just 
cool tips. No flaming type, no multilevel glows—just timesaving shortcuts and efficiency tips that 
will make you faster and better at Photoshop than you’d ever thought you’d be. 

Also, like my previous books, we spell out everything. So if you’ve been using Photoshop  
for years, don’t let it frustrate you because instead of just writing, “Create a new layer,” we usually 
write, “Create a new layer by clicking on the New Layer icon at the bottom of the Layers palette.” 
We do that because we want everyone, at any skill level, to be able to open the book to any page 
and start applying these cool tips to their work immediately. 

This book is built on the premise that “Speed Kills.” Because after all, if you get faster at Photo-
shop, you’ll have more time to be creative, and the more time you spend being creative, the more 
fun you’ll have. 

Is this book for Macintosh, Windows, or both?
This book is not only for Mac and Windows users, it’s for people who don’t even have a computer.  
In fact, it’s ideal for anyone with $29.99 (kidding). Because Photoshop is  identical on both the 
Macintosh and Windows operating systems, the book is for both Mac and Windows users.  
However, the keyboards on a Mac and PC are slightly different, so every time we give a keyboard 
shortcut, we give both the Mac and Windows shortcuts. (Well, there is one other difference— 
in Mac OS X you’ll find Photoshop’s Preferences under the new Photoshop menu instead of  
the Edit menu like it used to be in the Mac OS and still is in Windows.)

How to use this book
This book is designed to be read while moving at a high rate of speed. If you’re barreling down the 
highway going 80 mph, weaving in and out of traffic, that’s the ideal time to turn to Chapter Six 
to read the tip on “How to assist EMS workers with using the Jaws of Life.” Okay, admittedly, that’s 
probably not a good idea, so instead, just make sure you open this book in front of your computer 
so you can dive right into the tips. Remember, the one who dies with the most cool tips wins.

What not to do
You’re almost ready to get to the tips, but first a word of caution: “Caution.” There. Now you’re 
ready. Actually, we did want to point out that the only two actual sidebar tips in the entire book 
are on these two pages. So, don’t go rippin’ through the book looking for all those little sidebar 
tips, because we intentionally left the sidebars blank. Why? So we could write another book called 
The Missing Killer Tips Sidebars, just in case Felix ever sees what the payment is for a house on the beach. 

TIP

You’re doing  
it again! Stop 
looking at these 
sidebars. See, 
they’re intoxi-
cating—you’re 
drawn to them 
even after you 
know it’s not really 
a tip. Okay, here’s 
a real tip: If you 
like sidebar tips, 
buy this book.

xix
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Do you remember the song “Burn 

Rubber” by the Gap Band from 

back in the early 80s? Remember 

it goes: “Burn rubber on me, Charlene… 

whoa, no….” Not ringing any bells? It 

doesn’t matter. This chapter has nothing 

to do with burning rubber—I was just 

curious to see if you’re as old as I am 

(which is young. Very young. I heard that 

song accidentally on an oldies station in  

my dad’s car). 

This chapter is dedicated to making the 

time you spend using type in Photoshop 

more productive. Here’s the weird thing 

about Photoshop type—back in version 

6, Adobe added most of the high-end 

typography features found in Adobe’s high-

end page layout program, InDesign. Which 

made me think, “Why?” I can’t imagine 

setting a book or magazine article in 

Photoshop, because when Photoshop type 

gets below 12 points, it starts to get fuzzy, 

so laying out columns of text and tweaking 

the balance, spacing, and paragraph  

specs for columns of type just doesn’t  

make sense. Then I figured out what’s  

going on. Somebody at Adobe must be 

hittin’ the crack pipe. Could that be it?  

Or is it so not, that it freaks you out.

 Burn Rubber
smokin’ type tips
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Now that Photoshop CS can really give you 
type in a circle, getting a perfect circle that 
you can add type to is not as obvious as you’d 

think. To get this perfect circle, click on the Shape tools in the Toolbox and choose the Ellipse tool 
from the flyout menu. Then go up to the Options Bar, and in the second group of icons from the 
left, click on the middle icon, which creates a regular path, rather than a Shape layer or a pixel-
based shape. Then, hold the Shift key, and drag out your circle (the Shift key constrains the shape 
to a perfect circle). Now you can move your Type tool over the circle, and it will change into a Type 
on a Path cursor. Click on the circle, and get to typin’.

GETTING TYPE IN A PERFECT CIRCLE

In all previous versions of Photo-
shop, when you typed in a quo-
tation mark (“) or apostrophe (‘), 
what Photoshop gave you was 
the straight-up-and-down inch 
mark (") or foot mark (') instead. 

They’re called “dumb quotes.” Luckily, back in Photoshop 7.0, Adobe brought these typo-
graphically challenged dummies into line, and now they’re properly applied as “curly quotes” 
by default, which is great. That is unless you have to actually type an inch mark or a foot mark. 
Here’s the workaround—when it comes time to type in an inch or foot mark, go under the 
Photoshop menu, under Preferences, and choose General (in Windows, Preferences can be 
found under the Edit menu). In the General Preferences dialog, turn off Use Smart Quotes, and 
then type in your characters. When you’re done, return to the General Preferences and turn 
them back on to bring typographic order to your world. 

I NEED MY DUMB QUOTES AGAIN
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ONE-CLICK ACCESS TO THE COPYRIGHT SYMBOL, AND MORE

Looking for some special type characters, 
like ©, ™, or ®? If you’re not fussy about these 
characters actually being a font, you can find 
them in the default set of Custom Shapes. Just 
get the Custom Shape tool, click on the Shape 
Picker up in the Options Bar, and you’ll find all 
three special characters there, in the default set 
of shapes.

RESETTING YOUR TYPE

If you’re into typography, Photoshop CS gives you 
loads of typographical control. You can adjust ev-
erything from tracking, kerning, and dozens of other 
characteristics. The downside is—the Character 
palette (where we make most of these tweaks) keeps 
your last used settings as a default. If you did some 
major type tweaking to your last line of type, it might 
need some major “un-doing” in the Character palette 
to get you back to normal type settings. Rather 
than manually resetting every field, to quickly reset 
Photoshop’s type to its “default” standard settings, 
just go to the Character palette, and choose Reset 
Character from the palette’s pop-down menu. 
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When you want to automatically high-
light the type from a Type layer and 
switch to the Type tool at the same time 
to make some copy changes, just double-
click directly on the “T” icon in the Layers 
palette, next to the Type layer you want 
to edit, and blam! You’re ready to go. 

If you need to convert your Type layer into an im-
age layer, you can save some time by simply hold-
ing the Control key (PC: Right-click) and clicking 
directly on the Type layer name that appears in the 
Layers palette. A pop-up menu will appear where 
you can choose Rasterize Layer to instantly render 
your type. 

HIGHLIGHTING YOUR TEXT SUPER FAST!

RENDERING TEXT IN JUST ONE CLICK
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To create a “text box” for your type to fit within, select the Type tool, then click-and-drag out 
the area you want for your text box. Your type will now fit within that box. When you’re fin-
ished entering your text, just press Enter to get out of the text bounding box.

MADE TO FIT

TEXT-PATH-MAKING MANIAC

If you want to convert your Type layer into paths (so it looks 
as if you meticulously drew the type with the Pen tool—your 
clients won’t have to know), simply go under the Layer menu, 
under Type, and choose Create Work Path. 
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First, set your Foreground color to black 
(by pressing “d”). Choose the Type tool and 
create your text (you don’t have to rasterize 
the type). Then, open the image you want  
to appear inside your type and use the 
Move tool to drag it into your type docu-
ment. (It should appear on the layer above 
your Type layer. If it doesn’t, just go to the 
Layers palette and move it on top of your 
Type layer.) To put your image inside the 
type, press Command-G (PC: Control-G) 
and whammo—your image is masked into 
your type. You can reposition the image by 
using the Move tool. And since you didn’t 
rasterize your Type layer, your text remains 
totally editable—just click on the Type layer 
and start editing. You can add Layer Styles 
to your Type layer to further enhance the 
effect. If you’re not crazy about the image 
you picked, press Shift-Command-G (PC: 
Shift-Control-G) and remove the image. 

PICTURE THIS: PUTTING A PHOTO INSIDE TYPE
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Here’s a tip to quickly change typefaces and see the change 
while you make it. First, highlight the type you want to change, 
and then press Command-H (PC: Control-H) to hide the high-
lighting (the type is still highlighted; the highlight is just hidden 
from view). Then, up in the Options Bar, click once in the font 
field, then use the Up/Down Arrow keys on your keyboard to 
scroll through your installed typefaces. Man, do I love this one.

Earlier, I gave you the quick tip for rasterizing your 
type by Control-clicking (PC: Right-clicking) on 
your Type layer in the Layers palette, then choos-
ing Rasterize Layer from the pop-up menu that 
appears. Believe it or not, there’s an even faster 

way, if you don’t mind spending a minute or two up front setting 
it up, by creating an Action that rasterizes the type for you with 
just one key. Here’s how: Create a Type layer, then make the  
Actions palette visible. Choose New Action from the Actions pal-
ette pull-down menu (the circle with the right-facing arrow in it). 
Name your new Action “Rasterize Type Layers,” then, from the  
F-key pop-up menu, assign an F-key to this Action. Click the 
Record button (it’s where the OK button usually is), then go 
under the Layer menu, under Rasterize, and choose Type. Now go 

back to the Actions palette and click on the Stop button at the bottom of the palette (it’s the first 
button from the left). That’s it—your Action is written. Test it by creating a Type layer, then press-
ing the F-key you assigned to your Action. It should instantly rasterize (you’ll know if it worked, 
because the “T” icon on the Type layer will no longer be visible). 

FONTS, FONTS, AND MORE FONTS

MAKE YOUR TEXT JUMP INTO ACTION
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In Photoshop, you can change the color of your type without even selecting it first. “Why is that 
important?” you may ask. If you highlight your type to change its color using the Foreground 
Color Swatch in the Toolbox, the highlighting hides the color of your type so you can’t see any 
of your color changes while you’re in the Color Picker. So instead, after you commit your type by 
pressing the Enter key, click on the Color Swatch in the Options Bar (without highlighting your 
type first). As you change colors in the Color Picker, you’ll see your type update on the fly.

DOUBLE YOUR PLEASURE

SEEING YOUR TYPE CHANGE COLOR

We’ve already talked about rasterizing text, but once you’ve  
rasterized your Type layer into a regular image layer, your  
type is no longer editable (meaning you can’t go back and 
change type faces, type in a different word, adjust leading  
or kerning, etc.). Here’s a quick way around that limitation.  
Before rasterizing (rendering) your type, duplicate the Type layer 
by dragging it to the New Layer icon at the bottom of the Layers 
palette. Then, hide the original Type layer from view (by click-
ing on the Eye icon next to the original Type layer). That way, if 
you ever need to go back and change the word (or font, leading, 
etc.), you have the original editable Type layer still available. Just 
simply make it visible. 
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Here’s a tip that can save you a lot of tool switching when formatting your type. Once you 
create your type and while your cursor is still blinking somewhere in the text, if you need to 
move the type, you don’t have to switch to the Move tool—just move your Type cursor away 
from your type (either above, below, or an inch or so to the right or left), and your cursor will 
temporarily change to the Move tool. You can now simply click-and-drag your type. If you 
want to edit your type some more, just move your cursor back to the type and click where you 
need to make edits.

Here’s a cool little tip for changing 
your font size without having the 
Type tool active. Just click on your 
Type layer (in the Layers palette), 
then go under the Window menu 
and choose Character. When the 
Character palette appears, you 
can make changes to your type 
size, color, font, tracking, etc. It 
freaks you out, doesn’t it?

MOVE YOUR TYPE, WITHOUT SWITCHING TOOLS 

EDITING TEXT WITHOUT HIGHLIGHTING IT
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You can visually control the spacing between  
your type (which is much better than numeri-
cally trying to figure it out) by using the same 
keyboard shortcuts for adjusting type that 
Adobe Illustrator uses. Here’s how: To set the 
tracking tighter (tightening the space between 
each letter or word in a group), highlight the 
type then press Option-Left Arrow (PC: Alt-Left 
Arrow) to tighten. Press Option-Right Arrow 
(PC: Alt-Right Arrow) to add more space be-
tween a selected group of letters or words. To 
adjust the space between two individual let-
ters (called kerning) click your cursor between 
the two letters and use the same keyboard 
shortcuts mentioned above.

HONEY, I NEED SOME SPACE: VISUALLY ADJUST KERNING

RASTERIZE TIMES 2, 4, 6...

If you have multiple Type layers and you want to convert 
them all to image layers, there’s a way to do it without indi-
vidually rasterizing each. Simply go under the Layer menu, 
under Rasterize, and choose All Layers. This will rasterize all 
the Type layers at once.
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As you probably know, you can jump to most any tool in the Toolbox by pressing a single-key 
keyboard shortcut. (If you didn’t know that, sell your copy of Photoshop. Kidding. Just turn to 
Chapter 2 for some essential tips.) Here’s the problem: While creating type with the Type tool, 
if you press one of those one-key shortcuts (let’s say the letter “p” for the Pen tool), instead of 
jumping to the Pen tool, Photoshop types the letter “p”. It’ll drive you nuts. Okay, you won’t go 
nuts, but at the very least you’ll have a lot of typos. The reason is this: You have to tell Photo-
shop that you’re done editing your type. You do this in one of three ways: (1) Click on the check 
icon at the far right of the Options Bar, (2) press the Enter key, or (3) switch to another tool 
manually by clicking on it in the Toolbox. Any of these three options tells Photoshop that you’re 
done and lets you use the single-key shortcuts to switch tools.

TELL PHOTOSHOP WHEN YOU’RE DONE WITH TYPE

BRING THOSE TYPE LAYERS TOGETHER

How do you merge two Type layers together? Unfortunately, 
while they’re still editable Type layers, you can’t—you have  
to rasterize the layers first. Technically, you rasterize just one  
(the bottom of the two Type layers), and then make the top Type 
layer active and press Command-E (PC: Control-E) to merge these 
two layers together. However, when you do that, the top Type 
layer will automatically rasterize as the two layers are combined 
into one, so there’s really no way around it—with the exception 
of this little tip: Highlight the editable type on the top layer and 
choose Cut from the Edit menu. Switch to the lower Type layer, 
click your Type cursor once at the end of the type, press Return 
(PC: Enter) to start a new line, then choose Paste from the Edit 
menu to paste the contents of the top Type layer into the bottom 
Type layer. Then drag the old top Type layer into the Trash icon at 
the bottom of the Layers palette. Although it takes a little effort, 
now you have both layers combined into one layer (your goal), 
but the type remains totally editable (the bonus). 
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This tip relates to a previous tip, where you created what’s called 
a “text box” so that your type wraps within a text block, rather 
than running in one straight line. The tip is this: If you’ve cre-
ated some standard type by just clicking and typing rather than 

creating a paragraph text 
block, you’re not out of 
luck. While the Type layer 
is active, just go under the 
Layer menu, under Type, 
and choose Convert to 
Paragraph Text. Now your 
type will wrap within text 
box boundaries, and you 
can edit the boundaries by 
adjusting the corner and 
center points.

Although the Character palette has 
numeric controls for making your 
type fatter (horizontal scaling) or taller 
(vertical scaling), it’s usually easier to 
do these two functions visually (rather 
than numerically). Here’s how: First set 
your type, then with the type cursor 
still blinking somewhere in the text, 
press-and-hold the Command key (PC: 
Control key) to bring up the Free Trans-
form bounding box. To make your type 
fatter, click on the center handle on 
either side, release the Command key 
(PC: Control key), and drag outward. To 
make your type taller, grab the center 
handle on the top or bottom, release 
the Command key (PC: Control key), and 
drag upward or downward. 

THE LONG AND THE SHORT OF TYPE

MADE TO FIT: PART TWO 
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MAKING THE SPELL CHECKER OBEY YOUR COMMANDS

Photoshop’s spell checker isn’t just window 
dressing; it has a very robust spell-checking 
function, akin to Adobe InDesign’s own spell 
checker, but if you understand how it works, 
you can save yourself some time and frustra-
tion. Basically, if you highlight some text on a 
layer, it checks just the highlighted text, so if you 
highlight one word, it just checks that one word 
(even if there are dozens of words in your para-
graph). If you choose to spell check but don’t 
have anything highlighted, it checks your entire 
document, regardless of how many Type layers 
you have. It’s also helpful to know that it only checks real Type layers (layers that have a capital 
“T” as their thumbnail image in the Layers palette), and it cannot spell-check any layers with 
text that have been rasterized (converted from a Type layer into a regular image layer). 

EDITING TYPE ON A PATH

If you’ve created some type on a path, highlight-
ing that type to edit it (to change the font, color, 
spelling, etc.) can be kind of tricky. That’s why it’s 
quicker to go to the Layers palette and double-
click directly on the “T” thumbnail icon. This will 
highlight all the type on this layer, making it easy 
to type in some new text, or change some of the 
attributes. 
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We already showed you how to create a 
column of type by clicking-and-dragging the 
Type tool to create your “text box” so your 
text will wrap within that column. But here’s  
a quick little tip that lets you tell Photoshop 
exactly the width and height you’d like your 
type column to be (rather than just clicking-
and-dragging it out visually). With the Type 
tool, just hold the Option key (PC: Alt key) 
and click in your document and the Para-
graph Text Size dialog will appear where  
you can enter the exact size you’d like for 
your column.

EXACT SIZING FOR YOUR TEXT COLUMNS

REMOVING THOSE TYPOGRAPHICALLY INCORRECT SPACES

If you’re trying to set type that looks typo-
graphically correct in Photoshop, there’s an 
old habit you’ll have to break, and that’s the 
curse of putting two spaces at the end of every 
sentence. This is a holdover from people who 
at one time used traditional typewriters, where 
adding two spaces was necessary, but in type-
setting that’s a huge no-no. About 70% of the 
text I copy and paste from text files that people 
give me has two spaces, but I use this Photoshop tip to fix the problem in just seconds. First, go 
under the Edit menu and choose Find and Replace Text. In the Find field, press the Spacebar 
twice (entering two spaces), then in Change To, press the Spacebar just once. Click Change All, 
and every time Photoshop finds two spaces at the end of a sentence, it will replace it with just 
one, making you typographically correct. 
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This is a pretty darn slick tip 
for changing the font, size, or 
color of a number of different 
Type layers all at once. Here’s 
how it’s done: First, link all the 
layers that you want to adjust 
by clicking in the second col-
umn beside each Type layer. 
Once all the layers are linked, 
hold the Shift key and make 
your change. The change you 
make to one Type layer will 

also affect all the linked Type layers. The key is not to highlight your type. Just choose the Type 
tool and go straight to the Options Bar or the Character palette. Schweeeet!

TWEAK ALL YOUR TYPE IN ONE FELL SWOOP!

If you have a typeface that doesn’t have a bold 
or italic version available, don’t sweat it—Photo-
shop can make a fake bold or italic version for 
you. They’re called faux bold and faux italic (don’t 
pronounce them “fox bold” or the French will get 
really cranky about it. It’s pronounced “fo,” as in 
“Fe, Fi, Fo, Fum”). To apply a faux style to the type, 
highlight your type and choose Faux Bold  
or Faux Italic from the Character palette’s pop-
down menu. Here’s another tip: Don’t forget 
to turn off these faux styles when you’re done, 
because they don’t automatically turn themselves 
off. Vive le Français!

DON’T HAVE ITALIC OR BOLD? DON’T SWEAT IT
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Canvas Size dialog, 59
Channel pop-up menu, 19
channels

Alpha, 217
Blue, 183
CMYK, 214
color, 200–201, 215
editing content on, 201
Lightness, 178
RGB, 214
selecting, 19
type in, 213
viewing, 200

Channels palette
accessing filters, 205
adding to selections  

with, 217
channel display, 201
removing noise, 183
sharpening images, 178, 193
Unsharp Mask, 191

Character palette, 93, 99
characters, special, 93
checkerboard pattern, 39
Clear Brush Controls  

command, 86
Clear Guides command, 14
clipboard, 169
Clipping Groups, 48
Clipping Masks, 48
clipping paths, 145
Clone Stamp tool, 187
cloned images, 187
CMYK channels, 214
CMYK color, 126
CMYK images, 193
CMYK inks, 161
CMYK mode

accessing filters in, 205
caution about switching 

from, 192
color corrections, 181
Color Picker, 216
conversions, 192–193, 205
gradients and, 186
monitors and, 161, 186

printing and, 161, 182,  
184, 186

sharpening images, 191
vs. RGB mode, 181, 192

CMYK Setup dialog, 193
collage, 66
color

accuracy of, 174
background, 59
banding, 178
canvas, 59
channels, 200–201, 215
CMYK. See CMYK mode
combining, 129
converting to grayscale, 204
copying, 50
correcting. See color 

correction
defaults, 41
duotones, 122
fills, 42
focusing attention with, 124
foreground, 49, 98
GIF images, 116
hexidecimal codes, 114, 116
hue, 192
indexed, 116
inks, 161
Lab, 178, 192, 202, 204
layers, 146
matching, 126
“mismatch” warning, 52
monitors and, 161, 202
Pantone, 25, 126
press-ready, 184
previewing, 162
printing, 161
replacing, 174, 184
RGB. See RGB mode
sampled, 50, 117, 194, 204
saturation, 192
separations, 181, 193
shadows, 127
shared images and, 202
Similar command, 40
spot, 181

sRGB, 52, 186
swapping, 185
two-color vs. four-color, 122
type, 98
Web and, 112, 116
Web-safe, 112

Color Balance, 84
color correction

CMYK vs. RGB mode, 181
correcting single color, 84
Curves Adjustment layer  

for, 210
default settings, 176
drag and drop feature, 210
flesh tones, 192
highlights, 174
multiple corrections, 189
multiple images, 210

color modes
CMYK. See CMYK mode
grayscale images and, 159, 

180, 204
Lab Color, 178, 192, 202, 204
printing and, 161
RGB. See RGB mode

Color palette, 17
Color Picker

CMYK mode, 216
Color Wheel, 128
Gamut Warning, 184
Pantone colors, 25
replacing color, 174
RGB mode, 216

color ramp, 17
Color Range command, 16
Color Range dialog, 204
Color Replacement tool, 184
Color Sampler tool, 194
Color Stops, 66
Color Swatches, 25, 57, 98, 184
color wheel, 128
columns, 104
commands

About Photoshop, 81
Add Noise, 178
Clear Brush Controls, 86
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Clear Guides, 14
Color Range, 16
Convert to Paragraph  

Text, 102
Create Layers, 144
Create Work Path, 95
Crop, 80
Define Brush Preset, 78
Despeckle, 179
Export Layers To Files, 135
Fade, 206
Feather, 123
Free Transform, 61, 131
Image Size, 113
Insert Path, 217
Load Selection, 55
Lock All Linked Layers, 137
Merge Visible, 80, 134, 154
New Set From Linked, 147
Paste Layer Style To  

Linked, 149
Purge All, 60
Rasterize Layer, 94, 97
Replace Color, 174
Rotate, 9
Save, 82
Save Actions, 208
Save for Web, 109, 111, 118
Save Selection, 55
Shadow/Highlight, 174, 176
Similar, 40
Timing, 87
timing, 87
Web Color, 116

Convert to Paragraph Text 
command, 102

copying items
Background layers, 75, 143
color, 50
images, 58, 69
Layer Masks, 150
layers, 23, 75, 141, 143

copyright symbol, 93
Create Layers command, 144
Create New Snapshot icon, 69
Create Work Path  

command, 95

Crop command, 80
Crop snapping, 159
Crop tool, 16, 43, 75, 129, 

159, 170
cropping. See also trimming

images, 16, 43, 80
photographs, 129
snapping and, 159
Web graphics, 109

cursors
selection shortcuts and, 37
Type cursor, 99

curve points, 191, 194, 215–216
curves

adjusting, 191, 194
drag-and-drop, 210
magnified view of, 18
reusing settings, 15

Curves Adjustment layer, 210
Curves dialog, 8, 18, 194, 216
Custom CMYK dialog, 193
Custom Color Picker, 25
Custom Shape tool, 93
Custom Thumbnail Size, 71, 86
customizing

brushes, 78, 86, 175
highlights, 176
shadows, 127, 176
shapes, 93
styles, 113
views, 71

cyan kicker, 124

D
Define Brush Preset  

command, 78
Delete Anchor Point tool, 20
deleting items

filters, 28
layers, 53, 111
points, 10
preferences, 163, 168

depth of field, 123
design tips, 121–131
Despeckle command, 179
diagonal guides, 209

digital cameras
EXIF data, 199
image resolution, 158
importing images, 158
Raw images, 198, 212, 220
removing noise from 

images, 183
sRGB color and, 52

Display and Cursors 
preferences, 158

distortion, 170
docking, 43
Document Bounds option, 159
documents. See files
drag and drop feature

color correction, 210
Curves Adjustment  

layer, 210
folders, 68
images, 78
layers, 138, 141–142
styles, 138

drawing lines, 209
Drop Shadow option, 125, 127
drop shadows

adding noise to, 188
angle adjustments, 142
blurred, 125
color, 127
Global Light feature  

and, 165
layers and, 142
noise and, 188
opacity, 125
printing over solid  

colors, 167
problems with, 165, 167
softness, 125
transparency, 125

dumb quotes, 92
duotones, 122
Duplicate Layer dialog, 141

E
Easter Eggs, 67
edge fringe, 66
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editing
channel content, 201
on paths, 103
text, 99
type, 98, 103

effects
3D, 208
brush, 39
Filter Gallery, 27
layers, 145, 152, 202
modifying intensity, 68
print, 208
scaling, 202
undoing, 68

EPS files, 45, 162
EPS Options dialog, 162
erasing items, 85
EXIF data, 199
Export Clipboard option, 169
Export Layers To Files 

command, 135
extensions

.atn, 171, 208

.psd, 170

.txt, 208
Extract function, 64
Eye icon, 138, 146
Eyedropper icon, 116
Eyedropper tool, 50, 111, 114, 

117, 189

F
Fade command, 206
Fade dialog, 177–178
Feather command, 123
Feather field, 165
Feather Selection dialog, 79
feathered selections, 56, 79
feathering, 56, 79, 165
fields, escaping, 24
File Browser

closing, 11
Custom Thumbnail Size, 71
docking and, 43
Full Screen Mode, 59, 71
jumping to folders, 68

nesting palettes, 29
opening 16-bit images, 198
previews and, 41
refreshing, 38
saving folders in, 29
saving setups, 2
searching in, 210
side-by-side previews, 86
thumbnails, 86

File Handling preferences, 112
files

assigning metadata to, 206
batch renaming, 34
closing, 60
converting layers to, 135
EPS, 45, 162
finding, 210
finding exact center, 4
flagged, 72
GIF, 108
JPEG, 115
layered, 135
presets, 4
recalling previous  

settings, 18
recent, 50
saving changes, 60
sharing, 202
size of, 108–109, 119,  

147, 170
text, 208
transparency and, 108

Fill dialog, 42, 55
fills

color, 42
shortcuts, 55
“un-filling” layers, 153

Filter Gallery
default settings, 3
deleting filters, 28
modifying settings, 26
showing effects in, 27
zooming in, 26, 28

filters
3D Transform, 48
accessing in CMYK  

mode, 205

applying, 206
Blur, 70, 79, 123, 179
controlling, 206
deleting, 28
Gaussian Blur, 70, 79, 179
grayscale images and, 159
layers and, 67, 207
Lens Flare, 221
multiple, 207
Photo Filters, 70
reapplying previous, 40
RGB, 159
Unsharp Mask, 178, 190–191

Find and Replace Text  
dialog, 104

finding items
files, 210
highlights, 189, 213
items in File Browser, 210
layers, 164
palettes, 10
photos, 210
shadows, 189, 213
text, 104

Flagged Files feature, 72
flattening layers, 80, 134, 170
flesh tones, 192–193
floating selections, 151
folders

dragging, 68
jumping to, 68
plug-ins, 161
saving in File Browser, 29
Web images, 115

fonts. See also text; type
changing, 97
changing size, 99
converting to paths, 126
converting to  

selections, 126
metadata, 35

foreground color, 49, 98
Foreground Color Swatch, 98
formats

GIF, 108–109
JPEG, 109, 162
TIFF, 167
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Free Transform bounding  
box, 164

Free Transform command, 
61, 131

Free Transform handles, 61
Free Transform tool, 77, 170
Freeform Pen options, 166
Freeform Pen tool, 203
Full Screen Mode, 6, 59, 71

G
gamut problems, 182, 184
Gamut Warning, 184
Gaussian Blur filter, 70, 79, 179
ghosting, 122
GIF files, 108
GIF format, 108–109
GIF images, 116
Global Light feature, 165
gradient banding, 178
Gradient Picker, 21
gradients

CMYK mode and, 186
color separations, 181
Color Stops, 66
prepress work and, 186
spot color, 181

graphic elements. See also 
images

cropping, 109
isolating, 122
overlapping, 123
for Web, 109, 113, 118

graphics tablet, 177, 209
grayscale images, 159, 204
Grayscale mode, 159, 180, 204
grids, 8
guides

diagonal, 209
flipping, 14
slicing images at, 110

H
Hand tool, 57, 71, 214
handles, Free Transform, 61

Healing Brush tool, 64, 175, 177
hexidecimal codes, 114, 116
hiding layers, 138
High Pass dialog, 180
highlighting text, 94
highlights. See also light

correcting, 174
customizing, 176
default settings, 176
finding, 189, 213
selecting, 204

Histogram palette
display options, 200
refreshing, 35

History Brush, 22, 124, 208
History feature, 207
History Logging, 198
History Options, 219
History palette

batch actions, 219
focusing attention with 

color, 124
snapshots, 69, 207
undo feature, 20, 76

History States, 219
horizontal guides, 209
HSV Picker, 128
HTML code, 114
HTML editor, 114
hue, 192
Hue/Saturation dialog, 192

I
Ignore Palettes option, 76
image correction, 173–185
Image Previews feature, 112
Image Size command, 113
Image Size dialog, 113, 185
ImageReady, 110–111

styles and, 113
Tile Maker, 117
Web animations, 114

images. See also graphic 
elements; photographs

16-bit, 198
before and after views, 187

batch converting for  
Web, 115

black-and-white, 180
Camera Raw, 198, 212, 220
centering with black 

background, 82
changing placement of, 71
cloning, 187
CMYK, 193
copying, 58, 69
cropping, 16, 43, 80
dragging, 78
fitting to screen, 49
flagged, 72
grayscale, 159, 204
importing, 158
JPEG, 119
line art, 180, 185
moving with Hand tool, 71
navigating between, 13
noise in, 183
numbers in corner of, 108
opening, 11
optimized, 111
overlapping over text, 123
pasting, 58
previewing, 112
ranking, 51, 72
Raw, 198, 212, 220
resizing, 74
resolution. See resolution
RGB, 161, 192
scaling, 61
scanned, 23, 179–180
shared, 202
sharpening, 178, 180,  

190, 193
sliced, 110, 118
tiled, 65
viewing at 100% size, 49, 113
Web. See Web images

importing images, 158
indexed color, 116
Info palette, 218, 221
ink colors, 161
inkjet printers, 161
Input Levels slider, 122
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Insert Path command, 217
Internet. See Web
Intersect with Selection  

icon, 46
IPTC data, 199, 206
italic text, 105, 160

J
jaggies, 5
JPEG files, 115
JPEG format, 109, 162
JPEG images, 119

K
kerning, 100
keyboard

navigation, 211
text spacing, 100

keyboard shortcuts
Animations palette, 114
Blend Modes, 212
cursor and, 37
Fill dialog, 55
Gaussian Blur filter, 70
Layers palette, 149
modifier keys, 37
multiple undos, 76
navigation, 211
resizing images, 74
selection, 37

Keyboard Shortcuts editor, 70

L
Lab Color mode, 178, 192, 

202, 204
Lasso tool

drawing straight  
segments, 36

feathering, 56
jaggies and, 5
navigation control with, 214
Polygonal Lasso, 10
tips for, 5, 214

Layer Blend Modes, 207

Layer Comps feature, 139
Layer Effects, 145
Layer Masks

copying, 150
viewing as Rubyliths, 151
viewing separately, 151

Layer menu, 136
Layer Properties dialog, 146
layer sets, 147
Layer Style dialog, 125, 136, 

140, 142
Layer Style Drop Shadow 

dialog, 188
layered files, 135
layers

activating, 143
Adjustment, 70, 215
aligning, 144
background.  

See Background layers
blank, 175
Blend Modes, 137, 140
centered, 142, 144
color-coding, 146
comparing layouts, 139
converting to separate 

documents, 135
converting type layers to 

image layers, 94
copying, 23, 75, 141, 143
Curves Adjustment, 210
deleting, 53, 111
dragging between 

documents, 138, 
141–142

drop shadow angles, 142
effects, 145, 202
file size and, 147
filters and, 67, 207
finding, 164
flattening, 80, 134, 170
healing on, 175
hidden, 134, 138
jumping to, 134, 143,  

149, 168
layer-based slices, 118
linked, 137, 147, 149

locking/unlocking, 75, 137, 
146, 160

merging, 147
moving, 149
navigating, 134, 143, 149, 

168
nudging pixels in, 47
opacity, 140, 153–154
painting and, 146
problems with, 160, 164, 168
removing active effects 

from, 152
retouching and, 72
rotating, 9
selecting everything on, 150
selecting objects on,  

150–151
Shape, 25, 145
slices, 118
styles, 138–139, 142, 144, 

149, 152, 202
switching between, 149
tips for, 133–154
transparency, 143, 153
turning off checkerboard 

pattern, 39
Type, 94, 101, 146
“un-filling,” 153

Layers palette, 136, 148–149
Lens Flare filter, 221
Levels dialog, 122, 188
light. See also highlights

Global Light feature, 165
shadows and, 130

light source, 130
Lightness channel, 178
line art, 180, 185
Line tool, 209
lines

arrowheads, 77
drawing, 209

linked layers, 137, 147, 149
Load Selection command, 55
Lock All Linked Layers 

command, 137
Lock Transparent Pixels  

feature, 49
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locked layers, 75, 137, 146, 160
Luminosity mode, 178

M
Mac OS–based systems

Color Picker, 128
deleting Photoshop 

preferences, 163
Web graphics, 118

Magic Wand tool, 16
Magnetic Pen tool, 166
Marquee snapping, 159
masks

clipping, 48
layer, 150–151
Quick Mask mode, 203
selections and, 203, 215
Unsharp Mask filter, 178, 

190–191
Measure tool, 182, 218
measurement units, 34, 56, 

75, 218
memory

clipboard, 169
out-of-memory warnings, 22
performance and, 169
plug-ins and, 161
problems with, 22, 162, 169
purging, 60
requirements for, 162
undo feature and, 22

menus, hiding, 82
Merge Visible command, 80, 

134, 154
merging layers, 147
“Merlin Lives” Easter Egg, 67
messages

Gamut Warning, 184
“mismatch” warning, 52
out-of-memory warnings, 22
resetting warning  

dialogs, 44
metadata

assigning to multiple  
files, 206

assigning to photographs, 
199, 206

display options, 199
font sizes, 35

Metadata palette, 35, 199, 207
Midtone Input Levels slider, 

203–204
moiré patterns, 179
monitor

brightness, 118
CMYK mode and, 161, 186
color accuracy, 161, 202
prepress work and, 186
shared images and, 202

Move tool, 27, 47, 99, 168

N
navigation

between images, 13
jumping to folders, 68
jumping to layers, 134, 143, 

149, 168
jumping to tools, 101
keyboard, 211
Lasso tool, 214
layers, 134, 143, 149, 168

New dialog, 136
New Layer dialog, 160
New Set From Linked 

command, 147
New Snapshot button, 207
Ninness, Michael, 74, 82
noise

adding to images, 178
adding to shadows, 188
digital camera images  

and, 183
removing banding with, 178
removing from images, 183

O
objects

3D, 183
finding center of, 14

on layers, 150–151
measuring, 218
scanning, 183
selecting, 150–151
Step and Repeat  

function, 73
transforming, 61

opacity
healing process, 177
layers, 140, 153–154
shadows, 125
sharpening and, 180

Opacity slider, 153, 177
Open button, 135
Open Recent menu, 50
optimization

comparing image  
versions, 111

graphics for Web, 115
window speed and, 111

Options Bar, 21, 47

P
paint strokes, 13
painting

layers and, 146
pixels, 185

palettes
Actions, 115, 171, 211, 217
Animations, 114
Brushes, 39, 46, 65, 73
Channels. See Channels 

palette
Character, 93, 99
Color, 17
default locations, 54
docked, 52
in File Browser, 29
finding, 10
hiding/showing, 7, 51
Histogram, 35, 200
History. See History palette
Info, 218, 221
Layers, 136, 148–149
Metadata, 35, 199, 207
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minimizing, 51
nesting, 29
Paths, 58, 219
Preview, 2
protecting, 76
saving, 82
snapping, 37
Swatches, 57
Web-safe Color, 112
zooming, 76

Pantone colors, 25, 126
Paragraph Text Size  

dialog, 104
Paste Layer Style To Linked 

command, 149
pasting items

images, 58
layer styles, 149

Patch tool, 64
Path Selection tool, 69
paths

combining, 201
converting fonts to, 126
editing type on, 103
embedding into actions, 217
hiding around shapes, 25
resizing, 69
selections and, 58
Stroke Path tool, 85, 219
stroking portion of, 219
text, 95

Paths palette, 58, 219
patterns

checkerboard, 39
moiré, 179

PDF Presentations, 200, 220
PDF Security dialog, 220
Pen tool

Auto Add/Delete option, 20
combining paths with, 201
Magnetic options, 166
path selection, 58
resizing paths, 69
switching to Freeform  

tool, 203
tips for, 20

Pencil tool, 185
performance, 169
Perspective feature, 170
Photo Filters, 70
photographic brush tips, 65
photographs. See also images

assigning metadata to,  
199, 206

barrel distortion, 170
batch renaming, 34
comparing side-by-side, 86
cropping, 129
finding, 210
flagged, 72
flesh tones, 192–193
isolating elements on, 122
placing inside type, 96
ranking, 51, 72
Raw, 212
red eye, 184
retouching, 72

Photoshop
earlier versions of, 202
Easter Eggs, 67
History Logging, 198
IPTC data, 199
performance, 169
startup time, 161

pixels
feathered, 79
fixing stray, 16
moving selections by, 164
nudging, 47
painting, 185
removing edge fringe, 66
selecting on layers, 150
selection smoothing and, 16
transparent, 49

Playback Options dialog, 205
plug-ins

Camera Raw, 198
memory and, 161
trimming, 161

points
curve, 191, 194, 215–216
removing, 10
white, 188

Polygonal Lasso tool, 10
preferences

brush size, 158
deleting, 163, 168
Display and Cursors, 158
Export Clipboard, 169
File Handling, 112
Mac OS–based systems, 163
rebuilding, 168
recalling, 88
Windows-based  

systems, 163
Preferences dialog, 88
prepress cleanups, 211
prepress tips, 173, 186–194
presentations, 83, 200, 220
presets

brushes, 30, 46, 78
documents, 4

press-ready colors, 184
pressure sensitivity controls, 

177, 209
Preview palette, 2
previews

before and after views, 187
brushes, 73
color, 162
EPS files and, 162
File Browser and, 41
RGB, 201
side-by-side, 86
thumbnails, 220

printers, 161
printing

3D print effects, 208
CMYK mode, 161, 182,  

184, 186
color and, 161
color space and, 186
resolution, 158, 185
RGB mode, 161
text files, 208

production tips, 1–30
Proof Colors option, 216
.psd extension, 170
Purge All command, 60
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Q
Quick Mask mode, 203
quotation marks, 92

R
RAM

clipboard, 169
out-of-memory  

warnings, 22
performance and, 169
plug-ins and, 161
problems with, 22, 162, 169
purging, 60
requirements for, 162
undo feature and, 22

ranking images, 51, 72
Rasterize Layer command, 

94, 97
rasterizing type, 97–98, 

100, 131
Raw images, 198, 212, 220
Raw photographs, 212
Rectangular Marquee tool, 165
rectangular selections, 

164–165
red eye, 184
rendering text, 94
Replace Color command, 174
Resample Image option, 158
Reset button, 24
resolution

digital camera images, 158
high, 190
images, 158
low, 190
medium, 190
printing images, 158, 185
printing presses and, 190
scanned images, 179–180
Web and, 190

retouching process, 72, 175
RGB channels, 214
RGB filters, 159
RGB images, 161, 192
RGB mode

color corrections, 181

Color Picker, 216
conversions, 192–193, 205
grayscale images, 159
“mismatch” warning, 52
printing and, 161
sharpening images, 178
vs. CMYK mode, 181, 192

RGB preview, 201
RGB space, 186
Rotate command, 9
rotation, layers, 9
Rubylith, 151
rulers, 56

S
saturation, 192
Saturation slider, 192
Save Actions command, 208
Save command, 82
Save for Web command, 109, 

111, 118
Save Selection command, 55
saves, undoing, 82
saving

actions as text files, 208
changes to files, 60
File Browser setups, 2
folders, 29
palettes, 82
selections, 55
for Web, 109, 111, 118

Scale Layer Effects dialog, 202
scaling images, 61
scans

3D objects, 183
highlights and, 204
resolution, 179–180
shadows and, 204
straightening, 23, 182

screen cleanup, 7
scroll bars, 57
scrubbing, 42
scrubby sliders, 42
search feature

files, 210
highlights, 189, 213

items in File Browser, 210
layers, 164
palettes, 10
photos, 210
shadows, 189, 213
text, 104

selections
adding to with Channels 

palette, 217
contracting, 203
converting fonts to, 126
expanding, 164, 203
feathered, 56, 79
floating, 151
intersecting, 46
Lasso tool, 214
layers, 150–151
loading, 214, 217
masking and, 203, 215
moving, 38
objects, 150–151
paths as, 58
Quick Mask mode and, 203
rectangular, 164–165
rounded corners, 164–165
saving, 55
shortcuts, 37
softening edges of, 56
tips for, 215
transforming, 61

separation, color, 181, 193
Shadow/Highlight command, 

174, 176
shadows

adding noise to, 188
blurring, 125
color, 127
custom, 127, 176
decreasing, 176
default settings, 176
drop. See drop shadows
finding, 189, 213
length of, 130
light source and, 130
opacity of, 125
open, 174, 176
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printing over solid  
colors, 167

problems with, 165, 167
selecting, 204
softening, 125

Shape layer, 25, 145
Shape Picker, 93
Shape tools, 25, 93, 145
shapes

brush, 175
converting text to, 126
custom, 93
hiding paths around, 25

sharpening images, 178, 180, 
190, 193

shortcuts
Animations palette, 114
Blend Modes, 212
cursor and, 37
Fill dialog, 55
Gaussian Blur filter, 70
Layers palette, 149
modifier keys, 37
multiple undos, 76
navigation, 211
resizing images, 74
selection, 37

Show Channels in Color  
option, 200

Similar command, 40
Slice Options dialog, 118
Slice Select tool, 118
Slice tool, 108
sliced images, 110, 118
Slices From Guides feature, 110
slide shows, 83, 200, 220
sliders, 42, 68
smart quotes, 92
Snap To feature, 159
snapping

cropped images and, 159
palettes, 37

snapshots, 207
Spacebar, 57
spacing, text, 100, 104
special characters, 93

Special Effect Brushes, 65
spell checking, 103
Sponge tool, 182
spot color, 181
sRGB color space, 52, 186
startup time, 161
startup window, 44, 81
Step and Repeat function, 73
Stops, Color, 66
straight quotes, 92
straight segments, drawing, 36
Stroke Path tool, 85, 219
strokes

brush, 13
paint, 13
paths, 85, 219

styles
Background layers, 139
custom, 113
dragging and dropping, 138
ImageReady and, 113
layers, 138–139, 142, 144, 

149, 152, 202
Swatches palette, 57
symbols, 93

T
text. See also fonts; type

actions, 97
bold, 105, 160
columns, 104
converting shapes to, 126
editing, 99
faux styles for, 105, 160
finding, 104
highlighting, 94
horizontal scaling, 102
italic, 105, 160
kerning, 100
multiple adjustments to, 105
overlapping images over, 

123
rendering, 94
replacing, 104
spacing, 100, 104

spell checking, 103
vertical scaling, 102
warped, 160
wrapping, 102

text boxes, 95, 102
text files, 208
text paths, 95
Textured Image extraction, 64
Threshold Adjustment  

layer, 213
thumbnails

Custom Thumbnail Size, 71
File Browser, 86
file size and, 112
previews, 220
Raw, 220
size of, 71, 87
turning off, 112

TIFF format, 167
Tile Maker, 117
tiled backgrounds, 117
tiled images, 65
Timing command, 87
tonal adjustments, 19–20
Tool Tips, 73
Toolbox

hiding/showing, 45
jumping to tools in, 101

tools
Add Anchor Point, 20
Airbrush, 74
Background Eraser, 85
Brush, 158
Clone Stamp, 187
Color Replacement, 184
Color Sampler, 194
Crop, 16, 43, 75, 129, 159, 170
Custom Shape, 93
default settings, 54
Delete Anchor Point, 20
Eyedropper, 50, 111, 114, 

117, 189
Free Transform, 77, 170
Freeform Pen, 203
Hand, 57, 71, 214
Healing Brush, 64, 175, 177
jumping to, 101
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Lasso. See Lasso tool
Line, 209
Magic Wand, 16
Magnetic Pen, 166
Measure, 182, 218
Move, 27, 47, 99, 168
Patch, 64
Path Selection, 69
Pen, 20, 58, 69, 166, 201, 203
Pencil, 185
Polygonal Lasso, 10
Rectangular Marquee, 165
rotating through, 53
Shape, 25, 93, 145
Slice, 108
Slice Select, 118
Sponge, 182
Stroke Path, 85, 219
Type, 94, 101, 126
Zoom, 36, 49, 76, 113

transformations
3D Transform filter, 48
Free Transform bounding 

box, 164
Free Transform command, 

61, 131
Free Transform handles, 61
Free Transform tool, 77, 170
objects, 61
selections, 61

transparency
backgrounds, 111
creating, 111
file size and, 108
layers, 143, 153
pixels, 49

Transparent option, 136
Trim dialog, 109
trimming. See also cropping

plug-ins, 161
Web graphics, 109

troubleshooting, 157–171
actions, 171, 205
banding, 178
barrel distortion, 170
brushes, 158
color printing, 161

Crop snapping, 159
deleting preferences,  

163, 168
EPS previews, 162
faux styles, 160
gamut problems, 182, 184
grayscale images, 159
layer navigation, 168
memory problems, 22,  

162, 169
“mismatch” warning, 52
moiré patterns, 179
performance, 169
print resolution, 158
rebuilding preferences, 168
resetting warning  

dialogs, 44
selection problems,  

164–165
shadows, 165, 167
slow startup, 161
Warped Text function, 160

.txt extension, 208
type. See also fonts; text

in channels, 213
in circular format, 92
color, 98
editing, 98, 103
moving, 99
on paths, 103
placing photos inside, 96
rasterizing, 97–98, 100, 131
resetting, 93
sharpness of, 114
for Web, 114

Type cursor, 99
Type layers, 94, 101, 146
Type tool, 94, 101, 126
typeface tips, 91–105

U
undo feature

brushes, 22
History Brush, 22
History palette, 20, 207
modifying effects, 68

multiple undo shortcut, 76
out-of-memory warnings 

and, 22
undoing saves, 82

Units & Rulers Preferences 
dialog, 56

Unsharp Mask filter, 178, 
190–191

Use All Layers option, 72

V
vector EPS files, 45
vertical guides, 209
views, custom, 71

W
Wacom tablet, 177, 209
warning dialogs, 44
warnings

Gamut Warning, 184
“mismatch” warning, 52
out-of-memory  

warnings, 22
resetting warning  

dialogs, 44
warped text, 160
Web

actions from, 171
color and, 112, 116
image resolution and, 190
sliced images, 118
tips for, 107–119
type size and, 114

Web animations, 114
Web browsers, 112
Web Color command, 116
Web color values, 116
Web images. See also images

batch converting images  
to, 115

cropping, 109
cross-platform issues, 118
sharpness of, 110
viewing at 100% size, 113
zooming and, 110
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Web pages, 118
Web-safe Color palette, 112
Web-safe colors, 112
Welcome Screen, 44
white point setting, 188
windows

rotating through, 111
speed of, 111
startup, 44, 81
Welcome Screen, 44
zooming, 76

Windows-based systems
Color Picker, 128
deleting Photoshop 

preferences, 163
Web graphics, 118

wireless pens, 177

X
X coordinates, 221

Y
Y coordinates, 221

Z
Zoom field, 6
Zoom tool, 36, 49, 76, 113
zooming

entering zoom  
percentages, 113

Filter Gallery, 26, 28
in/out, 36
palettes, 76
for sharper web images, 110
tiled images, 65
windows, 76
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